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SUMMARY: 31 
This protocol describes the steps to generate a 3D model of metabolite distribution during 32 
trypanosomatid infection, including sample collection, metabolite extraction, an overview of 33 
liquid chromatography-tandem mass spectrometry data acquisition, 3D model generation, and 34 
finally, data visualization. 35 
 36 
ABSTRACT: 37 
Pathogen tropism and disease tropism refer to the tissue locations selectively colonized or 38 
damaged by pathogens, leading to localized disease symptoms. Human-infective trypanosomatid 39 
parasites include Trypanosoma cruzi, the causative agent of Chagas disease; Trypanosoma brucei, 40 
the causative agent of sleeping sickness; and Leishmania species, causative agents of 41 
leishmaniasis. Jointly, they affect 20 million people across the globe. These parasites show 42 
specific tropism: heart, esophagus, colon for T. cruzi, adipose tissue, pancreas, skin, circulatory 43 
system and central nervous system for T. brucei, skin for dermotropic Leishmania strains, and 44 
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liver, spleen, and bone marrow for viscerotropic Leishmania strains. A spatial perspective is 45 
therefore essential to understand trypanosomatid disease pathogenesis. Chemical cartography 46 
generates 3D visualizations of small molecule abundance generated via liquid chromatography-47 
mass spectrometry, in comparison to microbiological and immunological parameters. This 48 
protocol demonstrates how chemical cartography can be applied to study pathogenic processes 49 
during trypanosomatid infection, beginning from systematic tissue sampling and metabolite 50 
extraction, followed by liquid chromatography-tandem mass spectrometry data acquisition, and 51 
concluding with the generation of 3D maps of metabolite distribution. This method can be used 52 
for multiple research questions, such as nutrient requirements for tissue colonization by T. cruzi, 53 
T. brucei, or Leishmania, immunometabolism at sites of infection, and the relationship between 54 
local tissue metabolic perturbation and clinical disease symptoms, leading to comprehensive 55 
insight into trypanosomatid disease pathogenesis. 56 
 57 
INTRODUCTION: 58 
Trypanosomatid parasites consist of Leishmania species, African trypanosomes (Trypanosoma 59 
brucei), and American trypanosomes (Trypanosoma cruzi). Leishmania protozoa cause 60 
leishmaniasis, which includes self-healing and self-limited localized cutaneous leishmaniasis, 61 
mucocutaneous leishmaniasis in which the mucosal tissues of the mouth, nose, and throat 62 
become damaged, and visceral leishmaniasis with parasite tropism to the visceral organs causing 63 
fever and hepatosplenomegaly1,2. T. brucei causes Human African trypanosomiasis (HAT), also 64 
known as sleeping sickness, mainly reported in African countries3. The clinical signs and 65 
symptoms include hepatosplenomegaly, fever, headache, musculoskeletal pains, 66 
lymphadenopathies, and anemia in the hemo-lymphatic stage when parasites localize to the 67 
bloodstream and lymphatics. This is followed by the meningo-encephalitic stage, where parasites 68 
localize to the central nervous system and cause sleep disturbance, behavioral alteration, and 69 
eventually fatal comas4. T. cruzi causes Chagas disease, endemic in the Americas. Infected 70 
individuals experience an initial acute stage, usually asymptomatic, with broad parasite tropism. 71 
About 10%–30% of infected individuals experience chronic stage symptoms after decades of 72 
infection, characterized by megaoesophagus, megacolon, and cardiovascular complications5,6. 73 
 74 
Metabolomics studies small molecular species (50–1,500 Da), including biological compounds 75 
from primary or secondary metabolism and externally-derived compounds such as drugs or food-76 
derived molecules. In the context of host-pathogen interactions, metabolomics can explore the 77 
impact of infection on host metabolite environments, crucial in accessing the effect of the 78 
pathogen on the host. It can also assess pathogen adaptations to the host nutritional and 79 
immunological environment7–9. Mass spectrometry (MS) and nuclear magnetic resonance (NMR) 80 
spectroscopy are common metabolomics tools used to identify, quantify, and characterize 81 
metabolites. This "omics" approach can also be applied to biomarker discovery and drug 82 
development10,11. 83 
 84 
Given the specific tissue tropism of trypanosomatid parasites, spatial metabolomics analyses can 85 
enable significant insight into the pathogenesis of the diseases they cause. Mapping the spatial 86 
distribution of metabolites revealed metabolites locally affected by chronic Trypanosoma cruzi 87 
infection in mouse heart tissue and acute and long-term Trypanosoma cruzi infection in the 88 



 

mouse gastrointestinal tract6,12,13. Specifically, 3D chemical cartography demonstrated a 89 
disconnect between parasite persistence and metabolic alterations in the heart tissue of 90 
chronically Trypanosoma cruzi-infected mice. Metabolism was most perturbed in lower and 91 
apical segments of the heart, matching with sites of Chagas disease symptoms (cardiac apical 92 
aneurysms). Metabolite families perturbed by infection at specific cardiac sites and correlated to 93 
disease severity include acylcarnitines and glycerophosphocholines12–14. In the gastrointestinal 94 
tract, persistent metabolic alterations concurred with sites of Chagas disease symptoms: 95 
esophagus and colon. In contrast, metabolism is re-normalized at sites not associated with 96 
Chagas disease symptoms, such as the small intestine. Metabolites locally perturbed by infection 97 
in the gastrointestinal tract include acylcarnitines, glycerophosphocholines, kynurenine, 98 
tryptophan, and cholic acid. In addition, these analyses enabled the identification of a new 99 
metabolic mechanism of tolerance to Chagas disease6. Applying these methods to the study of 100 
cutaneous leishmaniasis revealed significant metabolic perturbations at the site of the lesion, but 101 
also specific metabolic changes in lesion-adjacent, macroscopically healthy tissue. For example, 102 
glutamine was depleted at the lesion site, whereas glycerophosphocholines in the m/z (mass to 103 
charge ratio) 200–299, 400–499, 500–599, and 600–699 were significantly increased at the lesion 104 
site. PC (O-34:1) was only increased at lesion-adjacent sites15. 105 
 106 
The goal of this manuscript is to demonstrate the steps necessary to generate 3D models of 107 
metabolite distribution ("chemical cartography") as applied to trypanosomatid parasite infection 108 
models (Figure 1). This approach builds on several critical advances in the context of 109 
metabolomics and metabolomics data processing, particularly the development of 'ili software 110 
to plot metabolomics data onto 3D models easily16. 111 
 112 
PROTOCOL: 113 
All animal experiments described were approved by the University of Oklahoma or the University 114 
of California San Diego Institutional Animal Care and Use Committee. All steps handling infectious 115 
material were performed inside a biosafety cabinet (class II, type A2) and according to local 116 
regulations. 117 
 118 
1. Tissue collection 119 
 120 
1.1. Infect appropriate trypanosomatid infection animal models, generally mice or hamsters. 121 
 122 
NOTE: There is a considerable variety of mouse models for trypanosomatid infection, depending 123 
on the desired symptoms to be produced, speed of disease progression, disease severity, etc. 124 
The users can choose at their convenience. 125 
 126 
1.1.1. For cutaneous leishmaniasis infection models, infect subcutaneously in the footpad or 127 
intradermally in the ear15. 128 
 129 
1.1.2. For visceral leishmaniasis infection models, infect intravenously1,17. 130 
 131 
1.1.3. For Chagas disease and sleeping sickness infection models, infect intraperitoneally6,12,18,19. 132 



 

Determine the parasite dose to use based on the parasite strain and planned time points. 133 
 134 
1.2. Plan sectioning positions. 135 
 136 
1.2.1. Plan to generate sections with a minimum of 10 mg of tissue per section. It is best to use 137 
30–50 mg. 138 
 139 
1.2.2. For Chagas disease infection models, plan to collect cardiac and gastrointestinal segments 140 
systematically. 141 
 142 
1.2.3. For cutaneous leishmaniasis infection models, collect lesional tissue and lesion-adjacent 143 
samples. 144 
 145 
1.2.4. For visceral leishmaniasis infection models, plan to collect spleen and multiple liver lobes. 146 
Additional tissue sites such as adipose tissue may also be of interest to collect. 147 
 148 
CAUTION: Samples from infected animals must be handled under the appropriate, institutionally-149 
approved biosafety protocol. This will generally involve personal protective equipment (PPE) 150 
requirements and only opening tubes and collecting samples inside a biosafety cabinet (class II, 151 
type A2). 152 
 153 
1.3. Label and weigh tubes for homogenization. 154 
 155 
1.3.1. Use the tube type appropriate for the available homogenization system. For a TissueLyser, 156 
use 2 mL microcentrifuge tubes. 157 
 158 
1.3.2. Euthanize mice at the desired infection timepoints using isoflurane overdose as approved 159 
by institutional IACUC or according to IACUC-approved protocol. 160 
 161 
1.3.3. Section tissue systematically as planned, with one section per tube. 162 
 163 
1.3.4. Remember to wash sample collection equipment between samples with extraction 164 
solvent (50% methanol in this protocol). 165 
 166 
1.4. Keeping tube lid open, immediately snap freeze samples in liquid nitrogen. 167 
 168 
CAUTION: Do not close tubes until any liquid nitrogen entered the tube has wholly evaporated 169 
to prevent tubes from exploding as nitrogen expands. Take adequate steps to ensure that the 170 
skin does not come in contact with liquid nitrogen (use cryo gloves and forceps to hold the tubes). 171 
Wear a safety face shield. 172 
 173 
1.5. Store the tubes on dry ice until all the desired samples have been collected. 174 
 175 
1.6. Pause point: store samples at -80 °C until ready to do extractions. 176 



 

 177 
1.7. Weigh tubes to determine tissue sample weight. Record in a spreadsheet. 178 
 179 
1.7.1. Keep the samples frozen during the weighing process: keep tubes on dry ice, rapidly 180 
weigh, put back on dry ice right away. Do not allow the samples to thaw while weighing. 181 
 182 
2. Metabolite extraction 183 
 184 
NOTE: Only LC-MS grade liquids and reagents must be used throughout. This method was 185 
adapted from Reference20. 186 
 187 
2.1. Prepare all extraction solvents (LC-MS grade H2O, LC-MS grade methanol, spiked with 4 188 
µM of sulfachlorpyridazine, LC-MS grade dichloromethane: methanol spiked with 2 µM of 189 
sulfachlorpyridazine) in 1 L glass bottles, using dedicated glassware. 190 
 191 
NOTE: Volume to be prepared should be calculated based on sample weights, considering 500 µL 192 
of water per 50 mg of sample, 500 µL of methanol spiked with 4 µM of sulfachlorpyridazine per 193 
50 mg of sample and 1,000 µL of prechilled dichloromethane: methanol spiked with 2 µM of 194 
sulfachlorpyridazine per 50 mg of sample, increasing the calculated volume by 10% to allow for 195 
pipetting inaccuracy. Store extraction solvent at 4 °C at least overnight to pre-chill. 196 
 197 
2.2. Perform water-based homogenization of the tissue samples as per the steps mentioned 198 
below. 199 
 200 
2.2.1. Add one 5 mm stainless steel bead (see Table of Materials) to each of the 2 mL 201 
microcentrifuge tubes containing tissue samples, using a bead dispenser. Keep the tubes on ice. 202 
 203 
2.2.2. Make one blank tube containing LC-MS grade H2O that will go through all the steps and 204 
serve as an extraction blank. Use the average H2O volume from sample extractions. Add chilled 205 
LC-MS grade H2O to the frozen tissue samples. 206 
 207 
2.2.2.1. Normalize water volume to tissue weight by adding 500 µL of water / 50 mg of 208 
sample, using the sample weights calculated at step 1.7. 209 
 210 
CAUTION: If handling biohazardous samples, continue to follow the appropriate, institutionally-211 
approved biosafety protocol. This will generally involve requirements for personal protective 212 
equipment (PPE) and opening tubes only inside the biosafety cabinet (class II, type A2). 213 
 214 
2.2.3. Homogenize samples at 25 Hz speed for 3 min using a tissue homogenizer (see Table of 215 
Materials). 216 
 217 
2.2.3.1. Close tubes tightly to avoid spilling the reagents during processing. 218 
 219 
2.2.4. Collect about 1/10th of the homogenization volume for DNA extraction, qPCR, protein-220 



 

based analyses, or other analyses (if desired). Store in a microcentrifuge tube or 96-well plate 221 
(depending on the volume collected) for up to 6 months at -80 °C, if DNA extraction experiments 222 
are to be performed on a different day. Longer storage durations may be possible but have not 223 
been tested. 224 
 225 
2.2.4.1. Perform DNA extractions using any standard commercial kit for mammalian DNA 226 
extraction (see Table of Materials) from tissues as described in Reference13. Quantify DNA yield 227 
and store the extracted DNA at -20 °C. Acceptable DNA quantity and quality for qPCR has been 228 
observed even up to 3 years later. 229 
 230 
NOTE: This step can be performed on frozen homogenate on a subsequent day from metabolite 231 
extraction. 232 
 233 
2.2.4.2. Perform qPCR as described in Reference13, using 180 ng of extracted DNA. 234 
 235 
NOTE: This can be performed on DNA collected on a previous day and frozen at -20 °C. 236 
 237 
2.2.4.2.1. In the case of studies on T. cruzi infection, use the following primers: 238 
ASTCGGCTGATCGTTTTCGA and AATTCCTCCAAGCAGCGGATA to quantify parasite levels21 and the 239 
following primers to normalize to host DNA levels TCCCTCTCATCAGTTCTATGGCCCA and 240 
CAGCAAGCATCTATGCACTTAGACCCC22 (see Table of Materials). 241 
 242 
NOTE: The recommended qPCR cycles are as follows: denature at 95 °C for 10 min; perform 40 243 
cycles at 95 °C for 30 s, and then 58 °C for 60 s, and finally 72 °C for 60 s. Perform melting curve 244 
analysis as appropriate for the available thermocycler. Process data using the ∆∆Ct method23 to 245 
obtain relative parasite load between sampling sites. Absolute quantification can be obtained by 246 
comparing sample-derived ∆∆Ct values to a standard curve generated from known amounts of 247 
parasites, spiked into uninfected tissue samples, and extracted as in steps 2.2 to 2.2.4.1. 248 
 249 
2.2.4.3. Perform protein-based characterization of immune responses using multiplexed 250 
cytokine kits or standard commercial ELISA kits (see Table of Materials) as described in 251 
Reference13 on the stored homogenate. 252 
 253 
2.2.5. Save at least half of the 500 µL of the homogenization volume for metabolite extraction. 254 
 255 
2.3. Perform aqueous metabolite extraction. 256 
 257 
NOTE: Solvent selection can be adapted based on the chemical properties of metabolites of 258 
interest. 259 
 260 
2.3.1. Add ice-cold LC-MS grade methanol spiked with 4 µM of sulfachlorpyridazine to the 261 
homogenate to achieve a final concentration of 50% methanol with 2 µM of sulfachlorpyridazine 262 
in water. 263 
 264 
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CAUTION: Methanol is flammable and hazardous. Use appropriate safety procedures, including 265 
handling inside a fume hood or biosafety cabinet. 266 
 267 
2.3.2. Homogenize samples in a tissue homogenizer at 25 Hz speed for 3 min. Centrifuge 268 
samples at 16,000 x g at 4 °C for 10 min. 269 
 270 
2.3.3. Collect an equal volume of supernatant into a 96-well-plate. Select the volume to match 271 
the smallest volume of methanol + water combined across all samples. This is the aqueous 272 
fraction. 273 
 274 
2.3.3.1. Set aside any remaining aqueous homogenate supernatant at -80 °C as a backup. 275 
 276 
2.3.4. Keep the solid residue on ice while collecting the supernatants. 277 
 278 
2.3.5. Dry aqueous extraction supernatant until dry (~3 h or overnight). Use maximum speed 279 
and no heating. 280 
 281 
2.3.6. Freeze the dried 96-well-plate at -80 °C. 282 
 283 
2.4. Perform organic metabolite extraction. 284 
 285 
NOTE: Solvent selection can be adapted based on the chemical properties of metabolites of 286 
interest. 287 
 288 
2.4.1. Add 1,000 µL per 50 mg of the sample of prechilled dichloromethane: methanol spiked 289 
with 2 µM of sulfachlorpyridazine to the solid residue from step 2.3.4. 290 
 291 
CAUTION: Use appropriate safety procedures when handling solvents, including handling inside 292 
a fume hood with a good flow rate. 293 
 294 
2.4.2. Homogenize samples in a tissue homogenizer at 25 Hz speed for 5 min. Centrifuge the 295 
samples at 16,000 x g at 4 °C for 10 min. 296 
 297 
2.4.3. Collect an equal volume of supernatant into a 96-well-plate. Select the volume to match 298 
the smallest volume of dichloromethane: methanol, across all samples. This is the organic 299 
fraction. 300 
 301 
2.4.4. Store the pellet at -80 °C as a backup. Store the remaining organic extract at -80 °C as a 302 
backup. Air-dry the organic extract in a fume hood overnight. 303 
 304 
2.4.5. Freeze the dried 96-well-plate at -80 °C. 305 
 306 
3. LC-MS data acquisition 307 
 308 



 

3.1. Resuspend aqueous and organic extracts into 60 µL each of 50% methanol + 2 µM of 309 
sulfadimethoxine, and combine. Sonicate for 10 min; then, centrifuge for 10 min and transfer the 310 
supernatant to a clean 96-wellplate. Seal with zone-free plate seal and place the plate in an LC 311 
autosampler. 312 
 313 
CAUTION: Use appropriate safety procedures when handling solvents, including handling inside 314 
a fume hood with a good flow rate. 315 
 316 
3.2. Connect appropriate mobile phases to the LC system (see Table of Materials). 317 
 318 
NOTE: For positive mode reversed-phase LC, authors recommend LC-MS-grade H2O + 0.1% formic 319 
acid as mobile phase A and LC-MS-grade acetonitrile + 0.1% formic acid as mobile phase B with 320 
a flow rate of 0.5 mL/min and a 7.5 min LC gradient. Recommended gradient steps are as 321 
published in Reference6: 0–1 min, 2% B; 1–2.5 min, linear increase to 98% B; 2.5–4.5 min, hold at 322 
98% B; 4.5–5.5 min, linear decrease to 2% B; 5.5–7.5 min, hold at 2% B. 323 
 324 
3.3. Ensure that the instrument is clean. Calibrate MS in both positive and negative mode. 325 
 326 
3.4. Perform MS performance evaluation as appropriate for the instrument. 327 
 328 
3.5. Create MS run sequence. 329 
 330 
3.5.1. Start with 2 blanks, 2 standards (6-mixes), and 5 pooled quality controls (QC) in a dilution 331 
series, beginning at 2 μL of injection volume and increasing stepwise to 30 μL injection volume. 332 
 333 
3.5.2. Randomize the sample order. 334 
 335 
3.5.3. After every 12 samples, run a blank, and then a pooled QC. 336 
 337 
3.6. Connect C8 LC column (1.7 µm particle size, 100 Å pore size, 50 x 2.1 mm length x internal 338 
diameter) and monitor for leaks and excessive backpressure. Fix issues as per instrument 339 
standard operating procedure. 340 
 341 
3.7. Start MS run sequence and collect data-dependent LC-MS/MS data. 342 
 343 
NOTE: For a Q-Exactive Plus MS instrument, use Heated Electrospray Ionization and data-344 
dependent MS2 acquisition (top 5) in positive mode, a resolution of 70,000 for MS1 and 17,500 345 
for MS2, AGC Target of 1E6 for MS1 and 2E5 for MS2, maximum IT of 100 ms for both MS1 and 346 
MS2, scan range to 100–1500 m/z for MS1, and MS2 isolation window of 1 m/z. Set sheath gas 347 
to 35, aux gas to 10 and sweep gas to 0, spray voltage to 3.8 kV, capillary temperature to 320 °C, 348 
S-lens RF level to 50, and aux gas temperature to 350 °C. 349 
 350 
3.7.1. Verify the data quality: check initial blanks (confirm lack of major peaks), standards 351 
(confirm the presence of expected peaks and symmetric peak shape), and QCs (confirm the 352 



 

presence of expected peaks, peak shape, and expected peak intensity). 353 
 354 
3.7.2. Periodically monitor MS run during the run sequence. 355 
 356 
3.8. Once the run is finished, check the data for any missed injections or other errors. 357 
 358 
3.9. Store the LC column as recommended by the manufacturer. Remove and store samples 359 
at -80 °C. 360 
 361 
3.10. Upload raw data to the data repository. 362 
 363 
NOTE: MassIVE (massive.ucsd.edu) is recommended to enable the downstream link to molecular 364 
networking for metabolite annotations24,25. 365 
 366 
4. LC-MS data processing 367 
 368 
4.1. Convert raw files to open format (.mzXML or .mzML) using MSConvert26. 369 
 370 
4.1.1. Upload raw data and mzXML or mzML data to the data repository. 371 
 372 
4.2. Generate feature table. There are multiple tools to do so (MZmine, MS-DIAL, openMS, 373 
XCMS, etc.27–30). 374 
 375 
NOTE: MZmine is recommended because it is free, open-source, and can directly import mzXML 376 
files after MSconvert, has graphical user interface options for processing data and monitoring the 377 
impact of parameter selection, and can directly export to GNPS for molecular networking24. 378 
 379 
NOTE: Follow tool documentation and use parameters appropriate for the available instrument. 380 
Additional details can also be found in Reference31. 381 
 382 
4.2.1. Export feature table.csv. 383 
 384 
5. 3D model generation 385 
 386 
5.1. Hand-draw 3D model de novo to scale as per the steps mentioned below. 387 
 388 
5.1.1. Take a picture of the organ of interest. 389 
 390 
5.1.2. Perform the following in SketchUp software (see Table of Materials) as mentioned below. 391 
 392 
5.1.2.1. Delete the default picture of a man that appears when the software opens. 393 
 394 
5.1.2.2. Click on File > Import to import a picture of the organs of interest. 395 
 396 
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5.1.2.3. Click on the Lines tool and select the Freehand option. Use the pencil tool to trace 397 
and draw the outlines of the organs of interest. Ensure to close the line by drawing all the way 398 
back to the starting point. Once the line has been successfully closed, the drawn area will 399 
automatically appear shaded. 400 
 401 
5.1.2.4. Select the Push/Pull tool and pull up on the shaded area to convert the drawing 402 
from 2D to 3D. 403 
 404 
5.1.2.5. Delete the organ picture: select the Eraser button, and then right-click on the 405 
picture and select Erase. 406 
 407 
5.1.2.6. Export the file in .dae format: File > Export > 3D Model. 408 
 409 
5.1.3. Improve the realism of the model as per the steps mentioned below. 410 
 411 
5.1.3.1. Import the model into MeshLab software (see Table of Materials): open MeshLab 412 
and select File > Import Mesh. Select the .dae model generated at the previous step. A Pre-Open 413 
Options menu will pop up. Select OK. 414 
 415 
5.1.3.2. Select Wireframe on the top menu. Then, select: Filters > Remeshing, 416 
Simplification and Reconstruction > Subdivision surfaces: Midpoint. Leave all values as default 417 
and select Apply twice. Visually inspect the wireframe view of the model to ensure it is finely 418 
gridded. Close the pop-up menu. 419 
 420 
5.1.3.3. Export the model in .stl format: File > Export Mesh As, and then select STL File 421 
Format (*.stl) in the Files of Type dropdown menu. Click on Save. Select OK in the next pop-up 422 
menu. 423 
 424 
5.1.3.4. Open the Meshmixer software (see Table of Materials). Click on the Import (+) 425 
button. Select the .stl file generated at the previous step. Use the Sculpt > Brushes > Drag and 426 
Sculpt > Brushes > Inflate tools to pull out the model's surfaces that need to be rounded out. 427 
 428 
5.1.3.5. Once the model has the desired appearance, save it in .stl format: File > Export. 429 
Name the file as desired and select STL Binary Format (*.stl) in the Save as type dropdown menu. 430 
Click on Save. If a pop-up menu appears, click on Continue. 431 
 432 
6. 'ili plot generation 433 
 434 
6.1. Obtain coordinates for the positions in the 3D model that correspond to the sampling 435 
sites. 436 
 437 
6.1.1. Open the 3D model from step 5.1.3.5 in the MeshLab software: File > Import Mesh. Select 438 
the model generated in step 5.1.3.5. Click on OK in the Post-Open Processing pop-up window. 439 
 440 



 

6.1.2. To obtain x, y, and z coordinates for each sampling spot: select the PickPoints tool, and 441 
then right-click at regularly spaced intervals across the 3D model surface. Once all the desired 442 
coordinates have been selected, click on the top-most Save button in the Form pop-up window. 443 
 444 
NOTE: This will export the coordinates in .pp file format. This file can be opened in spreadsheet 445 
software. 446 
 447 
6.1.3. In spreadsheet software: Open the .pp file generated in step 6.1.2. Adjust data display 448 
using Data > Text to Columns > Delimited. Click on Next, and then select Space, and click on 449 
Finish. 450 
 451 
6.1.4. Reformat so that only numerical values remain in the spreadsheet cells by selecting Home 452 
> Find & Select > Replace. In the Find what box, enter: y=". Leave the Replace with box empty. 453 
Click on Replace All, and then on OK. Repeat for x=" and for z=" and for " />. Values are now 454 
ready for step 6.2. 455 
 456 
6.2. Make the 'ili feature table. This method was adapted from Reference16. 457 
 458 
6.2.1. In a spreadsheet software, build the feature table. Rows correspond to each position and 459 
columns to data. 460 
 461 
NOTE: The first columns must be the position name (sample name), followed by x, y, and z 462 
coordinates of the sampling spots obtained at step 6.1.2 (with column headers x, y, z). The fifth 463 
column must be titled "radius". 464 
 465 
6.2.2. Paste the appropriate metadata and metabolite feature abundance in the subsequent 466 
spreadsheet columns. 467 
 468 
6.2.3. In column "radius", enter the desired size of the sampling spots to be visualized on the 469 
model. Determine the values for radius empirically: enter 1 as default, and then assess whether 470 
radius or coordinates need to be adjusted in step 6.3. Save the file in .csv format (File > Save As), 471 
and then select CSV (Comma delimited) (*.csv) in the dropdown menu. Name the file as desired. 472 
Click on Save. 473 
 474 
6.3. Open the data in 'ili (software developed by16). 475 
 476 
6.3.1. Open the 'ili website (ili.embl.de). Select Surface. Drag and drop the created 3D model 477 
into the browser window. Drag and drop the created feature table into the same browser 478 
window. 479 
 480 
6.3.2. Use the legend at the bottom-right corner to project the desired data column on the 3D 481 
model. Ensure that the spots and radii selected in step 6.2.1 match the sampling sites. If 482 
necessary, adjust values in the feature table, or choose additional coordinates in the MeshLab 483 
(see step 6.1.2). 484 



 

 485 
NOTE: Visualization can also be improved by selecting the Spots > Border Opacity and setting the 486 
slider to its maximal value. 487 
 488 
6.3.3. Consecutively select each data column to assess the distribution of this metabolite 489 
feature on the 3D model. 490 
 491 
NOTE: This approach can also be used to visualize only specific metabolite features of interest, 492 
for example, those with p < 0.05 or a certain fold change between infected and uninfected 493 
samples, as determined in external statistical analysis tools. Features to visualize may also be 494 
selected outside of 'ili through machine learning approaches such as a random forest. 495 
 496 
6.4. Perform linear/log data visualization as per the steps mentioned below. 497 
 498 
6.4.1. Using the Mapping tab at the top right of the page, select Linear or Logarithmic in the 499 
Scale drop-down menu. 500 
 501 
6.4.2. Set the same scale for all plots if visualizing multiple features. 502 
 503 
NOTE: The website automatically chooses the minimum and maximum for each data column to 504 
display. 505 
 506 
6.4.3. To set the scale manually, deselect the Auto Min/Max option and enter the desired 507 
scaling. All data will now be displayed within the same scale. 508 
 509 
6.5. Change the color scale of the data (grayscale, blue-white-red, etc.). 510 
 511 
6.5.1. Change the color scale to the desired color scheme in the Mapping menu using the Color 512 
Map drop-down menu. Ensure that the selected color scheme is color-blind-friendly. 513 
 514 
6.6. To change the color of the 3D model or the background color, use Color and Background 515 
options under the 3D menu. 516 
 517 
6.7. Hide 3D axes by unselecting the Show the Origin box under the 3D menu. 518 
 519 
6.8. Save the image by screenshotting, using the snipping tool, or the shortcut key Crtl + S for 520 
Windows or Linux and ⌘ + S on OS X. 521 
 522 
REPRESENTATIVE RESULTS: 523 
The number of metabolite features obtained depends on the tissue type analyzed and data 524 
processing parameters. For example, this protocol has been used to analyze the spatial impact of 525 
T. cruzi infection on the gastrointestinal tract metabolome in a mouse model of T. cruzi infection. 526 
In our previous work, male C3H/HeJ were injected intraperitoneally with 1,000 CL + luc T. cruzi 527 
parasites32,6. Animals were euthanized 12 or 89 days post-infection, and a chemical cartography 528 



 

analysis of 13 contiguous segments of the gastrointestinal tract was performed as described in 529 
this protocol. This analysis led to a feature table of 5,502 features, which were then visualized 530 
into 3D using the steps described in this protocol. This approach enables the visualization of 531 
metabolite features in individual animals that are high at the site of high parasite load 532 
(kynurenine, Figure 2B vs. parasite load, Figure 2A), of metabolites with differential distribution 533 
across tissue regions (glutamine, Figure 2C) and metabolite features that are found at 534 
comparable levels across small and large intestines (LPE 16:0 Figure 2D). Kynurenine was selected 535 
for visualization because of its known relationship to inflammation and prior publications on the 536 
ability of kynurenine-derived metabolites to regulate the T. cruzi load33. Random forest-based 537 
machine learning models had previously revealed an association between kynurenine levels and 538 
infection status6. Glutamine was selected for a visualization based on previous publications 539 
demonstrating a relationship between in vitro glutamine availability and T. cruzi drug 540 
sensitivity34. Differential distribution was confirmed using logistic regression, p < 0.05. LPE 16:0 541 
was selected after visual inspection of the data to discover metabolite features found at 542 
comparable levels across tissue sites. 543 
 544 
FIGURE LEGENDS: 545 
 546 
Figure 1: Protocol overview. The illustration was created with BioRender.com. 547 
 548 
Figure 2: Chemical cartography analysis. Male C3H/HeJ were injected intraperitoneally with 549 
1,000 CL+luc T. cruzi parasites32. Animals were euthanized 12 or 89 days post-infection, and the 550 
gastrointestinal tract was collected and sectioned systematically (step 1)6. Metabolites were 551 
extracted as in step 2 and analyzed by LC-MS/MS. 3D model generation was performed using the 552 
SketchUp software (step 5), and data were plotted in 3D in step 6. (A) Parasite distribution in a 553 
specific mouse, 12 days post-infection. (B) Kynurenine metabolite distribution in the same 554 
mouse, 12 days post-infection. (C) Mean glutamine distribution across infected mice, 89 days 555 
post-infection. (D) Comparable levels of m/z 454.292 retention time 2.929 min, annotated as 2-556 
hexadecanoyl-sn-glycero-3-phosphoethanolamine (LPE 16:0), in the same mouse as in A and B in 557 
the small intestine and colon. Samples and data were generated in6. 558 
 559 
DISCUSSION: 560 
Understanding trypanosomatid infections is essential to guide novel drug development and 561 
treatment approaches. This chemical cartography method is uniquely poised to provide 562 
actionable insights into the relationship between metabolism and trypanosomatid disease 563 
pathogenesis, thus addressing this translational need. 564 
 565 
Only LC-MS grade solvents are recommended during metabolite extraction and MS analyses, to 566 
lessen background contamination. Polymeric contamination35, commonly derived from paraffin 567 
film and/or other plastics36–38, must be avoided where possible. Parafilm, in particular, must never 568 
be used. These aspects are crucial since LC-MS data quality depends on the materials used during 569 
sample preparation and metabolite extraction. Data quality should be ensured before generating 570 
'ili plots. In addition, generating these comprehensive spatial metabolomics maps requires the 571 
collection of all adjacent tissue samples and metabolite extraction from all collected samples to 572 



 

avoid gaps in these maps. Collection procedures, logistics of metabolite extraction and LC-MS 573 
analysis, and costs should thus be considered and planned accordingly. 574 
 575 
This protocol can be modified to meet user needs in multiple ways. For example, the polarity and 576 
solubility of solvents used during metabolite extraction will influence what metabolites are 577 
detected39. To maximize the diversity of detected metabolite features for untargeted chemical 578 
cartography analyses, combining multiple extraction steps and solvents is recommended. For 579 
example, this method utilizes dichloromethane, methanol, and water as extraction solvents 580 
because they enable accurate detection of nonpolar and polar molecules20,40. However, these 581 
solvents are not universally suitable for every MS experiment, and researchers should select 582 
extraction solvents based on the goals of their project. Likewise, different LC-MS/MS conditions 583 
can be used, such as replacing reversed-phase chromatography with normal phase 584 
chromatography. Alternative columns can also be used for reversed-phase data collection 585 
instead of C8 chromatography, though empirically, C8 chromatography is more robust to tissue 586 
lipids and has a lower clogging frequency. Conceptually, these protocols can also be applied to 587 
other mass spectrometry methods such as gas chromatography-mass spectrometry, etc. 588 
 589 
An alternative approach is mass spectrometry imaging. Indeed, unlike mass spectrometry 590 
imaging approaches, liquid chromatography-mass spectrometry does not inherently preserve 591 
spatial information10. Chemical cartography approaches bridge this gap by including sampling 592 
location at the time of project conceptualization, in the sample metadata, and at data processing 593 
steps. A strength of this chemical cartography approach, unlike mass spectrometry imaging, is 594 
the ability to provide confident annotations (Metabolomics Standards Initiative level 1 or level 2 595 
annotation confidence41), unlike mass spectrometry imaging where the bulk of applications rely 596 
on accurate mass only for annotation. Mass spectrometry imaging will enable fine-grained spatial 597 
mapping, sometimes down to the single-cell level, e.g.,42,43. In contrast, chemical cartography 598 
approaches enable large-scale cross-organ mapping of metabolite distribution without requiring 599 
highly specialized whole-animal cryosectioning skills. Chemical cartography provides 600 
complementary evidence to the many spatial transcriptomic approaches being developed, e.g.,44, 601 
with the advantage of focusing on the 'omics layer closest to the phenotype'45. Alternative 602 
methods for parasite load quantification include measuring bioluminescence at the time of 603 
sample collection6. Fine segments could also be collected to enable confocal or electron 604 
microscopy to assess localized parasite burden and tissue damage. The water homogenate, which 605 
is used for cytokine quantification in this protocol and prior publications13, could also be used to 606 
quantify protein-based markers of tissue damage. 607 
 608 
There are also multiple ways to obtain 3D models suitable to plot the resulting LC-MS data. In 609 
addition to the method suggested here, models can be purchased pre-made from various online 610 
vendors. Ensure that the terms of use match with the intended usage, especially concerning 611 
publication. Models for large organs can be generated de novo using 3D scanners according to 612 
scanner instructions. Alternatives such as MATLAB exist for generating and visualizing 3D models 613 
for chemical cartography46, but they were primarily implemented before the development of 614 
'ili16. MATLAB is a data analysis and programming tool suite offering a wide variety of applications 615 
across many fields. However, MATLAB is neither free nor open-source, and it requires familiarity 616 



 

with MATLAB interfaces, especially considering MATLAB was not developed for processing mass 617 
spectrometry data. This proposed method's alternatives, namely, SketchUp, Meshlab, and 'ili, are 618 
freely accessible, user-friendly, and offer similar functions as MATLAB for chemical cartography 619 
purposes. 620 
 621 
This method is robust concerning sample preparation and metabolite extraction. 622 
Troubleshooting is most often necessary at the LC-MS data acquisition step. This is beyond the 623 
scope of this article. Readers are directed to excellent publications on LC-MS data acquisition 624 
troubleshooting, including20,47. Likewise, the complexities of metabolite annotation are beyond 625 
the scope of this method's focus on 3D model generation. Useful references on this topic 626 
include24,25,48,49. 627 
 628 
While this method effectively explores disease pathogenesis, there are limitations to this 629 
approach, some of which are common across any metabolomics experiment. One such limitation 630 
is the low annotation rate of LC-MS features50, which is contingent upon reference spectral 631 
libraries' availability and quality. A further limitation is that this protocol does not preserve mRNA 632 
due to the incompatibility of RNA preservation reagents such as RNAlater with LC-MS/MS 633 
analysis. However, the protein quality is adequate for downstream analyses and thus can replace 634 
mRNA-based analyses. 635 
 636 
A chemical cartography approach to infection pathogenesis directly reflects how bacterial, viral, 637 
or parasitic infections develop in organ systems and cause localized disease. Analyzing these 638 
regional subsamples and generating 3D models ultimately conveys how metabolites function 639 
across three-dimensional space, shedding light on these previously unrecognized spatial 640 
dimensions of molecular biology. Using this protocol, for example, metabolite localization was 641 
compared to Trypanosoma cruzi parasite load. Results clarified the relationship between the 642 
pathogen and host tissue and also demonstrated the metabolic dynamics of Chagas disease 643 
symptom progression6. Chemical cartography methods have also been applied to various topics, 644 
such as human-built environment interaction51–53, the chemical makeup of organ systems like 645 
human skin46 and lungs54, and plant metabolism and environment interactions55. Future 646 
applications can involve assessing localized disease tolerance and resilience, or the relationship 647 
between local metabolite levels, pathogen tropism, and disease tropism in models beyond 648 
trypanosomatid infection. This approach should also have broad applicability to expand current 649 
pharmacokinetics protocols, to assess the relationship between local tissue drug levels and drug 650 
metabolism vs. overall metabolic context, tissue damage, and pathogen clearance. Overall, 651 
chemical cartography allows unique explorations of metabolite distributions in various sample 652 
types, with applications, including disease pathogenesis, human health, human-environment 653 
interactions, and microbial dynamics. 654 
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action. Please add more specific details (e.g. button clicks for software actions, numerical 

values for settings, etc) to your protocol steps. There should be enough detail in each step to 

supplement the actions seen in the video so that viewers can easily replicate the protocol. 

Response: As requested, we have added additional details. 
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6. Please add more details to your protocol steps: 

Step 2.1.1.3: Please specify the volume of water used. 

Response: We have made the requested change. Text now reads: “Use the average of H2O 

volume from sample extractions.” 

 

Step 4.1/4.2.1: Please move the website links to the References and cite the appropriate 

reference number in the lines. 

Response: Requested change has been made. 

 

Step 5.1: The Protocol should contain only action items that direct the reader to do 

something. Please move the discussion about the protocol to the Discussion. 

Response: Requested change has been made. 

 

9. Please include a one-line space between each protocol step and then highlight up to 3 

pages of the Protocol (including headings and spacing) that identifies the essential steps of the 

protocol for the video, i.e., the steps that should be visualized to tell the most cohesive story of 

the Protocol. Remember that non-highlighted Protocol steps will remain in the manuscript, and 

therefore will still be available to the reader. 

Response: We have made the requested change. 

 

10. Please cite Figure 1 in the manuscript text. 

Response: Figure 1 is cited in the text: “The goal of this manuscript is to demonstrate the 

steps necessary to generate 3D models of metabolite distribution (“chemical cartography”), as 

applied to trypanosomatid parasite infection models (Fig. 1)”. 

 

11. Please obtain explicit copyright permission to reuse any figures from a previous 

publication. Explicit permission can be expressed in the form of a letter from the editor or a link 

to the editorial policy that allows re-prints. Please upload this information as a .doc or .docx file 

to your Editorial Manager account. The Figure must be cited appropriately in the Figure Legend, 

i.e. “This figure has been modified from [citation].” 

Response: All figures were generated specifically for this publication. None are reused. 

 

12. As we are a methods journal, please ensure that the Discussion explicitly covers the 

following in detail in 3-6 paragraphs with citations: 

a) Critical steps within the protocol 

b) Any modifications and troubleshooting of the technique 

c) Any limitations of the technique 

d) The significance with respect to existing methods 

e) Any future applications of the technique 

Response: We discuss all requested topics: 

a) Critical steps within the protocol (lines 579-588 in simple markup view, 625-635 in 

expanded view). 

b) Any modifications and troubleshooting of the technique (lines 590-602 in simple markup 

view, 637-650 in expanded view; 623-634 in simple markup view, 671-682 in expanded view; 

and 636-641 in simple markup view, 684-689 in expanded view). 

c) Any limitations of the technique (lines 643-649 in simple markup view, 691-705 in 

expanded view). 



d) The significance with respect to existing methods (lines 604-621 in simple markup view, 

652-669 in expanded view). 

e) Any future applications of the technique (lines 651-668 in simple markup view, 713-730 in 

expanded view). 

 

 

13. Please ensure that the Table of Materials includes all the supplies (reagents, chemicals, 

instruments, equipment, software, etc.) used in the study. 

Response: We have verified that the Table of Materials includes all the supplies (reagents, 

chemicals, instruments, equipment, software, etc.) used in the study. 

 

____________________________________ 

Reviewers' comments: 

Reviewer #1: 

Manuscript Summary: 

In their manuscript entitles "Chemical Cartography Approaches to Study Trypanosomatid 

Infection", Dean et al., elaborate a protocol for chemical cartography through generating a 3D 

model of metabolite distribution during trypanosomatid infection. The work would have broader 

implications in delving host-parasite interaction and infection with a systemic approach. The 

authors aptly described the broad goal and implications of the method in infectious disease 

research and adequately elaborated the method. However, the need for the refinement of a few 

segments was felt. 

Response: We thank the reviewer for their appreciation of our work. 

 

Major Concerns: 

1. Details of the equipment used should have been mentioned unless there are some 

restrictions. Also, the selection of columns for LC should have been elaborated. 

Response: Per JoVE editorial instructions, we do not mention commercial instrument names 

in the text. Necessary instruments are listed in the Table of Materials. Where possible, we 

emphasize flexibility with regards to instrument selection, knowing that readers may not have 

access to the same instruments we do. Indeed, this protocol can be just as successful across a 

variety of different instruments, as long as they have the necessary capabilities listed. We have 

specified the selected LC column (lines 350 in simple markup view, 362-364 in expanded view 

and in the Table of Materials) and added the rationale for column selection to the discussion 

(lines 599-601 in simple markup view, 646-650 in expanded view). 

 

2. Detailed description and explanation of results (representative) is warranted. 

Response: As recommended, we have expanded our discussion of the representative 

results (lines 534-553 in simple markup view, 580-599 in expanded view). 

 

3. Mention of statistical parameters implemented is needed. 

Response: As recommended, we have added the statistical parameters used to support the 

features displayed in Representative results (lines 547-553 in simple markup view, 593-599 in 

expanded view).  

 

Minor Concerns: 

1. For Fig. 2: mention the entity/ substance for which the distribution is depicted in each 



image within the figure. It would make the distributions discernible and comparable at a glance. 

Response: We have made the recommended change. 

 

Reviewer #2: 

The manuscript for the Methods article titled "Chemical cartography approaches to study 

trypanosomatid infection" by Dean et al. describes step-by-step protocols for spatially resolved 

metabolomics by LC-MS, 3D model generation, and data visualization. The following points 

must be addressed prior to publication of the Methods article. 

1. The protocols section of the LC-MS data acquisition requires more details. For example, 

give specific details of the LC gradient used, the chromatographic column used, MS 

parameters, ionization conditions, etc. 

Response: We have added all the requested details (lines 350-360 in simple markup view, 

362-372 in expanded view). 

 

2. The "REPRESENTATIVE RESULTS" section appears highly cryptic; it only referrers to 

one analysis they performed in their previously published article (reference number 6) without 

giving any specific details here. The reader of the JoVE article should be able to understand, 

appreciate and if required repeat the whole process even if they don't have access to the 

original research article. Therefore, it is very important that this section is elaborated with a 

standalone identity. 

Response: As recommended, we have added additional details to this section  (lines 534-

553 in simple markup view, 580-599 in expanded view). 

 

3. Figure 2C, explain why glutamine distribution is plotted. Figure 2D, again, the authors 

referred to reference number 6 without giving any explanation of the use or significance of the 

particular exercise. Please provide a clear explanation (either in the main text, in the 

representative results section or in the legend itself) of the justification of the chosen 

metabolites. 

Response: As recommended, we have added additional details justifying the metabolites 

chosen for visualization (lines 545-553 in simple markup view, 591-599 in expanded view). 

 

 

Reviewer #3: 

Manuscript Summary: 

The manuscript Chemical cartography approaches to study Trypanosomatid infection is an 

interesting work that could be very useful to visualize the dynamics of infection by T cruzi in 

vivo. 

Response: We thank the reviewer for their appreciation of our work. 

 

It is necessary to know aspects of experimental infection with trypanoma cruzi and the 

essential point in order to evaluate the scope of the proposed methodology in having a second 

methodology that can control the infection and correlate 3D images, such as confocal 

microscopy, electron microscopy, or tissue damage marker detection. 

Response: As recommended, we have added additional details on parasite burden 

quantification and steps to measure disease-induced inflammatory responses (lines 221-251 in 

simple markup view, 237-262 in expanded view). In addition, we have expanded our discussion 

of alternative and complementary methods to highlight possible integration of our approach with 



microscopy (lines 618-619 in simple markup view, 666-667 in expanded view). We have also 

added more details on how animals were infected to Figure 2 legend. We do however wish to 

emphasize that an advantage of this chemical cartography method is its flexibility, which 

enables it to be applied to any desired trypanosomatid infection model. Thus, infection details 

should be determined based on the specific research questions of the users of this protocol, and 

we refrain from imposing a specific infection procedure. 


